
All efforts have been made to ensure the accuracy and completeness of the information contained in this document. RST Instruments Ltd reserves the right to change the information at any time and assumes no liability for its accuracy.

Copyright © 2018. RST Instruments Ltd. All rights reserved.

Document Number: ICM0074G

Release Date: December 17, 2018

RST INSTRUMENTS LTD.
11545 Kingston St.,
Maple Ridge, BC
CANADA V2X 0Z5

SALES + SERVICE + MANUFACTURING:
604 540 1100 | info@rstinstruments.com
TOLL FREE (USA & Canada) | 1-800-665-5599

www.rstinstruments.com
## TABLE OF REVISION

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Revision History</th>
<th>Date</th>
<th>Prepared By</th>
<th>Approved By</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>Formatting upgrades</td>
<td>18-10-2018</td>
<td>MP</td>
<td>PL</td>
</tr>
<tr>
<td>F</td>
<td>Movement zone section improved</td>
<td></td>
<td>PL</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>Updated Movement Zone section, significant restructuring</td>
<td>17-12-2018</td>
<td>PL, MP</td>
<td>PL</td>
</tr>
</tbody>
</table>
TABLE OF CONTENTS

1 INTRODUCTION ................................................................. 1

2 GETTING STARTED ............................................................. 1
   2.1 Installing the Software ................................................ 1
   2.2 Demo Software .......................................................... 1
   2.3 Help System ............................................................. 2

3 PLOT TYPES ......................................................................... 2
   3.1 Mean Deviation ............................................................ 2
   3.2 Incremental Displacement .............................................. 2
   3.3 Absolute Position ....................................................... 2
   3.4 Cumulative Displacement ............................................. 2
   3.5 Checksum .................................................................... 3
   3.6 Time Plot ..................................................................... 3
   3.7 Vector Plot .................................................................. 4
   3.8 Polar Plot .................................................................... 5

4 MENU ITEMS .......................................................................... 6
   4.1 Borehole Menu ............................................................ 6
   4.2 View Menu ................................................................... 6
   4.3 Edit Menu .................................................................... 8
   4.4 Window Menu ............................................................ 8
   4.5 Help Menu ................................................................... 8

5 DATA STRUCTURE ................................................................. 9

6 USING THE SOFTWARE ....................................................... 10
   6.1 Creating A New Site or Borehole ................................. 10
   6.2 Opening an Existing Borehole ...................................... 14
   6.3 Printing ......................................................................... 17
   6.4 Metafile Export .......................................................... 17
   6.5 Creating Reports ........................................................ 17

7 CREATING PLOTS ................................................................. 19
   7.1 Saving Views ............................................................... 20
   7.2 Plot Header/Title ........................................................ 21
   7.3 Text View .................................................................... 22

8 MANIPULATING PLOTS .......................................................... 24
   8.1 Plot Options ............................................................... 24
      8.1.1 The Cursor .......................................................... 24
      8.1.2 Panning ............................................................... 27
      8.1.3 Zoom Functions .................................................. 27
      8.1.4 Axis Properties .................................................... 28
      8.1.5 Graph Properties .................................................. 33
      8.1.6 Legend ................................................................. 38
      8.1.7 Shortcut Keys ....................................................... 39
8.2 Graph Coordinates .................................................................39
8.3 Top and Bottom Reference ......................................................39
8.4 Depth Drop-Down Box ............................................................40
8.5 Reading Units ........................................................................42
8.6 Depth Units ............................................................................42
8.7 Movement Zone .......................................................................43
8.8 Bias-Shift Correction ...............................................................44
8.9 Spiral Correction ....................................................................47
8.10 Indicating Layers on a Graph ..................................................49
8.11 Annotating Plot Points with Callouts .......................................51
8.12 Annotating Graphs with Text Boxes and Lines .......................54
8.13 Software Options ....................................................................55
8.14 Data Interpolation ...................................................................56
8.15 Custom View Settings .............................................................56
8.16 Filling or Excavating at the Borehole Location, Cutoff Depth ....56

9  COMPATIBLE FILE TYPES .........................................................57

10 IMPORTING RST INS 5.2 ANALOG INCLINOMETER DATA ........58
10.1 Converting Files ...................................................................58
10.2 Using Unidown Software .......................................................60

11 IMPORTING SINCO DATA .........................................................61
11.1 Inclinometer Survey Files ......................................................61
11.2 Spiral Survey Files .................................................................62

12 USB SECURITY KEY DRIVER INSTALLATION ......................63
12.1 Microsoft™ Windows 7 and Windows 10 Installation Procedure ...63

13 TROUBLESHOOTING ..............................................................66

14 CONTACT US .........................................................................69

---

LIST OF FIGURES

Figure 3-1 Time plot and depth option ...........................................3
Figure 3-2 Vector plot ..................................................................4
Figure 3-3 Polar plot ..................................................................5
Figure 4-1 Open view dialog .......................................................7
Figure 5-1 Data structure ............................................................9
Figure 6-1 Opening screen ..........................................................10
Figure 6-2 New Borehole Selection .............................................11
Figure 6-3 Browse New Files Dialog .........................................11
Figure 6-4 Borehole Selection ...................................................12
Figure 6-5 Create new borehole ................................................12
Figure 6-6 Created new borehole selection .................................13
Figure 6-7 Borehole selection .....................................................14
Figure 6-8 Browse Files dialog box .................................................................15
Figure 6-9 Adding files ..................................................................................16
Figure 6-10 Report label .................................................................................18
Figure 6-11 Open Report dialog .................................................................18
Figure 7-1 Axis view .......................................................................................19
Figure 7-2 Creating a new view ................................................................20
Figure 7-3 Edit – Main header dialog box ................................................21
Figure 7-4 Text view .......................................................................................23
Figure 8-1 Plot options ..................................................................................24
Figure 8-2 Cursor options ...........................................................................25
Figure 8-3 Cursor properties .......................................................................26
Figure 8-4 Pan options ................................................................................27
Figure 8-5 Zoom options .............................................................................28
Figure 8-6 Axis options ...............................................................................29
Figure 8-7 Axis scale ....................................................................................29
Figure 8-8 Center graph option .................................................................30
Figure 8-9 Axis units ....................................................................................31
Figure 8-10 Axis label ..................................................................................31
Figure 8-11 Axis ticks ..................................................................................32
Figure 8-12 Axis gridlines .........................................................................32
Figure 8-13 Graph options ..........................................................................33
Figure 8-14 Add files to view .......................................................................34
Figure 8-15 Graph title ................................................................................35
Figure 8-16 Graph footer ............................................................................35
Figure 8-17 Graph general ..........................................................................36
Figure 8-18 Custom plot properties ..........................................................37
Figure 8-19 Graph and plot properties ......................................................37
Figure 8-20 Legend Options .......................................................................38
Figure 8-21 Graph shortcut keys ...............................................................39
Figure 8-22 Borehole reference ................................................................40
Figure 8-23 Depth drop-down box ............................................................41
Figure 8-24 Reading units ..........................................................................42
Figure 8-25 Depth Units ..............................................................................43
Figure 8-26 Movement zone dialog ..........................................................44
Figure 8-27 Bias-shift correction dialog box ...........................................46
Figure 8-28 Bias shift properties ...............................................................46
Figure 8-29 Bias correction example ........................................................47
Figure 8-30 Spiral correction dialog ..........................................................48
Figure 8-31 Spiral Correction .....................................................................49
Figure 8-32 Layers edit ...............................................................................50
Figure 8-33 Edit layer ..................................................................................50
INTRODUCTION

RST Inclinalysis™ software is a powerful companion to the RST Digital Inclinometer System. This software allows the user to quickly and efficiently reduce large volumes of inclinometer data into a variety of formats suitable for presentation.

In addition to classic Vertical Inclinometer data, Inclinalysis™ will process and display Horizontal Inclinometer data in various formats.

Should any questions arise which are not covered by this manual, please refer to Section 14 for RST contact information.

GETTING STARTED

2.1 INSTALLING THE SOFTWARE

- Insert the disk into your CD-ROM drive or run the downloaded program setup file.
- Follow the on-screen instructions to install the software, specifying location of the folders.
- Install the special USB security key driver when prompted by the installation wizard.

CAUTION: PLEASE ENSURE THAT THE USB SECURITY KEY DRIVERS ARE INSTALLED ON YOUR COMPUTER BEFORE INSERTING THE KEY INTO YOUR USB PORT. FOLLOW THE STEP-BY-STEP INSTRUCTIONS IN SECTION 12. IN CASE OF USB DEVICE DRIVER INSTALLATION PROBLEMS, PLEASE REFER TO SECTION 13 FOR TROUBLESHOOTING TIPS.

- Insert the USB security key into an available USB port on your computer.
- Launch the software by choosing it from your program list under the Start Menu.

2.2 DEMO SOFTWARE

If you have not purchased the full version of the software, it will run in demo mode. The user will be able to access all the functions of the registered software; however, plots and reports will not be able to be saved, printed or exported to a metafile. Installation of the program is the same as in Section 2.1. Demo files are also included with the demo software to enable the user to explore many features of Inclinalysis™ software. Press F1 anytime to activate context sensitive help system.
2.3 Help System

The Inclinalysis™ software contains an extensive, built-in help system which can be activated anytime by pressing F1 or ‘Help’ icon. Context sensitive help is available for most tasks and dialog boxes; the “What’s This” question mark icon allows for quick pop-up help. Help resources are supplemented by keyword index and keyword search.

3 Plot Types

The RST Digital Inclinometer creates several different plot types to view and analyze inclinometer survey data. These plot types can be created and edited once a new Graph View has been opened (Section 4.2) and are located in the top tool bar.

3.1 Mean Deviation

During an inclinometer survey, readings are taken with a probe at intervals throughout the entire depth of the borehole. The probe is then turned 180 degrees and the survey is repeated. Ideally, when each specific reading is summed, the result should be zero (see checksum, Section 3.5). In reality, the sum is not zero as the probe always has a slight zero offset.

In order to minimize the effects of this offset, an average is taken of the difference of the two readings (i.e. \[
\left(\frac{A^+ - A^-}{2}\right)
\]). The mean deviation plots this average data for each depth.

3.2 Incremental Displacement

The incremental displacement plot uses the mean deviation data and compares it to the baseline survey file. In turn, this plot reveals the exact depth where displacements are actually occurring. It has the advantage in that errors do not have a chance to accumulate (unlike the cumulative displacement plot).

3.3 Absolute Position

This plot reveals the actual shape of the inclinometer casing as it has been installed. Although it does not show displacements as well as the other plots, it can reveal whether potential errors are being caused by non-vertical casing.

3.4 Cumulative Displacement

The most common presentation of inclinometer data, the cumulative displacement is the sum of the displacements from the base of the borehole. This plot shows the change in the position of the casing since the first set of readings. Caution must be
exercised as this plot is very sensitive to errors in the probe. Changes in probe calibration (drift) over time can affect the data significantly if there has been significant movement of the casing from vertical. In general, rapid deviations from the centreline over a few sets of readings are more important than gradual changes.

3.5 **CHECKSUM**

A checksum’s primary function is to verify data integrity (or quality) during a survey. A checksum is the mathematical addition of the A+, A- and the B+, B- readings from identical depths in the borehole. The checksum plot displays the checksum data for each depth interval. The most common cause of inaccuracies in inclinometer data is due to errors in probe placement. Large checksums are often the result of these placement errors. Any jumps in the checksum data can indicate a questionable reading. Small drifts in checksum data over time can indicate aging and the bumps and shocks a probe takes over normal use. RST recommends calibration of the probe on an annual basis, or more frequently if the checksums confirm a problem with the probe.

3.6 **TIME PLOT**

The **Time Plot** is a useful tool for monitoring specific movements at a particular depth over time. The individual depth can be chosen using the drop-down menu available in the main tool bar (see Section 8.3).

![Time Plot and Depth Option](image)

**FIGURE 3-1 TIME PLOT AND DEPTH OPTION**
The individual depths can be scrolled through using the arrow key and the corresponding depth will be displayed on the current plot view. The time plot will plot all the cumulative displacement data from each survey file for the corresponding depth, revealing trends and rates of movement at that specific depth interval.

For information on the time plot and displaying movement zones, please see Section 8.7.

3.7 VECTOR PLOT

The Vector Plot reveals the change in the magnitude and direction of the casing at a specific or user defined depth interval. As with the time plot, the depth can be changed easily by using the depth scroll box found on the main tool bar (red circle, Figure 3-1). It is possible to display both the Vector and Time plots on the screen simultaneously, which is a very useful feature for analytical purposes (see Figure 8-23 for an example).

![Vector Plot](image)

**Figure 3-2 Vector Plot**

In this manner, the user can scroll through the specific intervals and see the resultant change in magnitude and direction and also see how that depth changes over time.

For more information of vector plots and movements zones, please refer to Section 8.7.
3.8 Polar Plot

The polar plot shows displacement versus angle when viewed down the borehole. The plot type can be selected from graph menu. The following plot types are available:

- Mean Deviation
- Incremental Displacement
- Absolute Position
- Cumulative Displacement

The file legend can be used to turn on and off individual plots for clarity.

**Figure 3-3 Polar plot**
4 **MENU ITEMS**

The following sections describe the menu options available with Inclinalysis™.

4.1 **BOREHOLE MENU**

**Open Borehole**: Opens a dialog box with which the user is able to browse and select a project, site and a specific borehole to open. The software requires the specific directory structure created by the RST digital inclinometer system (please refer to Section 5).

**Recent Boreholes**: Keeps a list of the 3 most recent boreholes that have been opened.

**Report**: Allows the option to open another report, save the current report or print the report. Multiple reports can be created for a single borehole which allows the user to have custom plots and views for each particular report. **Print Report** prints the entire report (all of the windows that are currently open). For more information on creating reports, please refer to Section 6.5.

**Add/Remove Borehole Files**: Opens a dialog in which the user can specify which survey files are to be displayed with the program (Figure 6-9). The user can specify which file is displayed and the base file, along with header information.

**Print…**: Prints the current report on any local or network printer.

**Page Setup**: Allows the user to set the margins and place a border around all plots.

**Print Setup**: Edit and set specific printer options.

**Export TextView Data…**: Exports and saves data from the Text View. Please refer to Section 7.3.

**Export Metafile…**: Place the plotted graph into a metafile document.

**Options…**: Change various software options.

**Close**: Closes the current borehole data and plots that are open with the program.

**Exit**: Exits the RST Data Reduction Software.

4.2 **VIEW MENU**

**Open View…**: Opens a dialog box where the user can open and close the various available plot types. Also allows the option for copying, renaming or deleting the plot types as seen below:
New View: Creates a new plot on the screen. The user has the option of a graph view, text view, plan view, vector plot, or time plot:

- **Graph View**: Opens a window in which the user can plot graphs of the data. Shortcuts to change plot types are provided in the tool bar below the menu headings. Available graph types are outlined in Section 3.

- **Text View**: Opens a window in which you can view the raw and calculated data in table format. Options allow the user to quickly switch between raw data, checksum, mean deviation, incremental displacement, and cumulative displacement. A directory tree appears on the left which allows the user to navigate between different data sets. Please refer to Section 7.3.

- **Time Plot**: Opens a window in which the inclinometer data is plotted versus time for a specific or user-defined depth interval.

- **Vector Plot**: Opens a window which plots the vector direction of the A and B axes for a specific or user-defined depth interval.

Save View: Saves the current view.

Save View As...: Saves the current view under a chosen name.

Save Custom Settings: Saves the current graph settings as custom settings.

Force Custom Settings: Applies previously saved custom settings to the current graph view.

Add Files To View...: Adds borehole data files to the current view.

Toolbars: Reveals and hides the file toolbar, the plot type and graph options buttons.

Status Bar: Reveals and hides the status bar at the bottom of the screen.

Language: Chooses different language.
NOTE: LANGUAGE MODULES ARE AN OPTIONAL ADD-ON COMPONENT.

4.3 EDIT MENU

Header…: Allows the user to change the header options for the borehole. Borders can be added along with custom titles and other features (Figure 7-3).

Plot Properties…: Opens a window which shows the current data sets loaded for the borehole (including those which are disabled). Left clicking a data set brings up its properties menu where the user can change the colour and other text properties.

Layers…: Opens dialog box listing all underground settlement layers indicated on graphs.

Reading Units: Opens a fly-out in which the user can choose the x-axis display units. Options are: millimetres, metres, inches and feet.

Movement Zone…: Allows the user to specify movement zones to be displayed on both the time and vector plots (see Section 8.7).

Bias-Shift Correction…: Apply a bias-shift correction to individual survey files contained within the report. A separate bias-shift can be used for both the A and B axes. For more on Bias-Shift errors, please refer to Section 8.8.

Spiral Correction…: Applies a spiral correction to all data contained in the report. For more on Spiral Correction, please see Section 8.9.

Reference…: Change between a top or bottom reference for the inclinometer data (Section 8.3).

Borehole Changes…: Opens dialog box listing all collar level changes and borehole depth limitations.

4.4 WINDOW MENU

Cascade: Cascades all currently open windows across the screen.

Tile Horizontally: Tiles all currently open windows horizontally across the screen.

Tile Vertically: Tiles all currently open windows vertically across the screen.

A list of the current open views is also available allowing the user to flip between views on the screen.

4.5 HELP MENU

Help Topics: Opens a standard Windows™ help menu where the user can search on help topics for the program.

About Inclinalysis…: Displays the running version and release date of the software.

5 DATA STRUCTURE

The RST Digital Inclinometer system creates a specific data structure in which all the sites and borehole survey files are found. On the Pocket PC™ under My Documents, a folder is created called DigitalInclinometer. Under this folder name, two additional folders are created which correspond to the site name and the borehole name as seen below:

![Folder Structure Diagram]

In this case (Figure 5-1), the site name is RST and the name of the borehole is Parking Lot. When opening a borehole with the program (see Section 6), the user must browse to and open the folder DigitalInclinometer. The software automatically recognizes the hierarchy of the folders. You can then add specific borehole survey files to your view, as described in Section 6.1. Once the program is set up to recognize the folder, new survey files can be simply copied into the corresponding site or borehole folder. The new data can then be displayed in the program using the Add/Remove Borehole Files feature (described further in the following chapter).

NOTE: ONCE THE INITIAL SITE AND BOREHOLE IS CREATED IN INCLINALYSIS™, THE PROGRAM HAS THE ABILITY TO LOAD IN INCLINOMETER SURVEY FILES FROM VARIOUS LOCATIONS. HOWEVER, IT IS RECOMMENDED THAT ALL THE SURVEY FILES BE KEPT IN THE SAME FOLDER TO KEEP THEM ORGANISED.
6 USING THE SOFTWARE

6.1 CREATING A NEW SITE OR BOREHOLE

NOTE: VERTICAL INCLINOMETER DATA IS USED TO ILLUSTRATE EXAMPLES IN THE FOLLOWING SECTIONS. USERS SHOULD TREAT DATA FROM HORIZONTAL INCLINOMETERS EXACTLY THE SAME.

When the program is launched for the first time, the following screen will appear:

![Opening Screen](image)

*Figure 6-1 Opening Screen*

NOTE: BEFORE STARTING TO CREATE A NEW SITE OR BOREHOLE, YOU MUST KNOW THE LOCATION AND NAMES OF ALL THE RAW INCLINOMETER DATA.
1 Under the **Borehole** menu, select **Open Borehole** and the following dialog box will appear:

**Figure 6-2 NEW BOREHOLE SELECTION**

2 Press the **Browse Files** button to navigate to the folder RST Digital Inclinometer site and borehole files will be stored. Upon clicking on **Browse Files**, the following screen will appear:

**Figure 6-3 BROWSE NEW FILES DIALOG**

3 Highlight the desired folder and press **OK**.

4 You will be returned to the Borehole Selection screen (Figure 6-4). Since the new folder is empty, the Borehole Selection dialog will contain no entries.
5 Click on Create New Site or Borehole (Figure 6-4).

6 Click on the Create New Site (Figure 6-5) button and enter the name of the new site or accept the default. The site folder will contain all of the boreholes associated with this new site. Click OK to return to the Create Borehole dialog box. Overwrite the default borehole name if you wish and click OK. The Borehole Selection screen will be shown listing the newly created site and borehole (Figure 6-6).
7 Highlight the borehole and press **OK**.

8 Upon selecting a borehole, the program will automatically open the **Add Files to Borehole** dialog box.

9 To add a file to a borehole, press the **Add** button. A dialog box will open under the path or the particular borehole. If you have additional files in another location, you can navigate to that location at this point (this is usually not possible). When the appropriate file has been located, press **Open** and it will be added to the list. Several files can be chosen at once by holding down the **CTRL** or **SHIFT** keys as appropriate. The software is compatible with several file types, as indicated in Section 9.

10 Information regarding each file is displayed, including whether or not it is used as a base file, the filename, date/time of the survey, depth, interval, units and file type. If the user wishes to remove a file from the list at any time, simply highlight that particular file and press the **Remove** button. If a file needs to be temporarily disabled, simply place a check mark in the **Disabled** box. Disabling a file will prevent it from appearing in any plots or text views.

11 A base file can be specified by highlighting the appropriate file from the list and pressing the **Base** button. An asterisk will appear under the **Base** column confirming the selection. By default, after adding the data to a borehole, Inclinalysis™ will set the oldest file as the base file.

12 Header information is displayed at the top of each plot created by the program. Select the file which contains the desired header information by highlighting it in the list and pressing the **Use for Header** button.
NOTE: HEADER INFORMATION CURRENTLY ONLY APPLIES TO DATA WITH THE *.BCH FILE EXTENSION (SEE SECTION 9).

13 When complete, press the **Apply** button to proceed, or **Cancel** to cancel the action.

### 6.2 OPENING AN EXISTING BOREHOLE

**NOTE:** BEFORE STARTING, YOU MUST KNOW THE LOCATION AND NAMES OF ALL THE RAW INCLINOMETER DATAFILES THAT WILL BE REQUIRED TO DISPLAY GRAPHS IN INCLINALYSIS™.

1 Under the **Borehole** menu, select **Open Borehole**. The following dialog box will appear.

![Select Borehole dialog box](image)

**FIGURE 6-7 BOREHOLE SELECTION**

2 Press the **Browse Files** button to navigate to the appropriate directory which contains the RST Digital Inclinometer site and borehole files. Upon pressing **Browse Files**, the following screen will appear:
3 Browse for the folder which contains the site and borehole survey files that have been taken with the RST Digital Inclinometer system. This is a crucial step, as the program looks for a specific directory structure with which it recognizes the site and borehole files. Although it is possible to navigate to your ActiveSync folder (created by the ActiveSync software), it is highly recommended that you make a backup copy of this folder and navigate to the backup copy of the data. This ensures that no data is lost or corrupted. By default, sample files are installed in the Inclinalysis folder in My Documents.

![Browse for Folder dialog box](image)

**Figure 6-8 BROWSE FILES DIALOG BOX**

---

**CAUTION: NAVIGATION TO THE CORRECT FOLDER IS THE MOST CRUCIAL STEP. THE SOFTWARE MUST BE SET UP TO POINT TO THE CORRECT DIRECTORY STRUCTURE WHERE THE DIGITAL INCLINOMETER FILES ARE LOCATED. ONCE THE PROPER DIRECTORY IS SPECIFIED, THE SOFTWARE WILL AUTOMATICALLY UPDATE IT WITH THE SITE AND BOREHOLES THAT ARE ADDED TO THAT SPECIFIC DIRECTORY. FOR ADDITIONAL INFORMATION, PLEASE SEE SECTION 5. TO OPEN THE SAMPLE FILES, BROWSE TO THE DEFAULT DATA FILE FOLDER (MY DOCUMENTS\INCLINALYSIS).**

4 Once the folder named Inclinalysis is found, highlight it and press OK.

5 You will be returned to the Borehole Selection screen (Figure 6-7). If the correct folder has been chosen (see Section 5), a list of all the current site names will appear. Pressing the + button to the left of each site will expand to show all the boreholes contained under that particular site.
6 For example, Figure 6-7 shows a single site (the Roadway Project), which contains a single borehole, in this case named “Slope Stability”. Highlight the desired borehole (in this case, “Slope Stability”) and press OK.

7 Upon selection of a borehole, the program will automatically open the Add Files to Borehole dialog box (Figure 6-9).

8 Press the Add button to add a file. A dialog box will open under the path of that particular borehole. If, for some reason, you have additional files in another location, you can navigate to that location at this point (this is usually not possible). When the appropriate file is located, press Open and it will be added to the list. Several files can be chosen at once by holding down the CTRL or SHIFT keys as appropriate. This software is compatible with several file types as indicated in Section 9.

9 Information regarding each file is displayed, including whether or not it is used as a base file, the filename, date/time of the survey, depth, interval, units and file type. If at any time the user wishes to remove a file from the list, simply highlight that particular file and press the Remove button. If a file needs to be temporarily disabled, simply place a check mark in the Disabled box. Once a file is disabled, it will no longer appear in any plots or text views.

10 A base file can be specified by highlighting the appropriate file from the list and pressing the Base button. An asterisk will appear under the Base column, confirming the selection. By default, after adding the data to a borehole, Inclinalysis™ will set the oldest file as the base file.

11 Header information is displayed at the top of each plot created by the program. Select the file which contains the desired header information by highlighting it in the list and pressing the Use for Header button.
NOTE: HEADER INFORMATION CURRENTLY ONLY APPLIES TO DATA WITH THE *.BCH FILE EXTENSION (SEE SECTION 9).

12 When completed, press the **Apply** button, or else press **Cancel** to cancel to the action.

### 6.3 PRINTING

Located under the **Borehole** menu, the print function will print the active window to a local or network printer. The user also has the option of printing the entire report by selection **Print Report** located in the **Borehole Menu Report** fly out menu.

### 6.4 METAFILE EXPORT

It is often necessary to place the plotted graph into a word processing document. This can be accomplished by using the **Export Metafile** option available under the **Borehole** menu. Exported metafiles can be loaded into photo editing software, cropped, and imported into the word processor. This file is created in the Borehole Directory by default.

### 6.5 CREATING REPORTS

The user can create a **Report** at any time by choosing the **Report Save As**... feature found under the **Borehole Menu**. A report is useful if several different users are manipulating data for a single borehole and wish to have different plots for the same set of data. A report saves the current plot and text views with their associated properties. The active report is always displayed in the bottom right-hand corner of the screen as shown below.
Please note that when a report is open, any changes are saved automatically by the program. Therefore, once a report name is created, changes made to it occur automatically. This eliminates the need to save the report continuously.

Reports can be organised under the Report → Open option. When selected, the following dialog box will appear:
This dialog permits the manipulation of all reports that exist for the current borehole. New reports can be created, deleted, saved or renamed. Inclinalysis™ will always open the most recently manipulated report upon start-up.

7 CREATING PLOTS

Once a borehole is selected and the specific survey files are opened (Section 6.1), various plots can be created. By pressing Apply (Figure 6-9), the program will automatically create a graph view of the data (Figure 7-1).

![Figure 7-1 Axis View](image)

**Figure 7-1 Axis View**

This plot represents a single axis view which is created in its own separate window. Additional windows with different plots can be created by choosing New View under the View menu.
The program gives you the option of creating a graph view, text view, vector plot, or a time plot.

Shortcut keys are provided along the top tool bar which allows the user to create plots quickly and easily. Simply click on the desired plot type and the plot will be created in the current graph view window (time and vector plots will open in a new window). Available options for graphing include: mean deviation, incremental displacement, absolute position, cumulative displacement and checksum. Different plot types are explained in Section 3.

### 7.1 SAVING VIEWS

Once a view is created, it can be saved under a unique name by selecting View, Save or Save As…. In this manner, many different views can be saved under unique names.

Each saved view will have its unique settings: Scale, Graph Colors, Drawings, Callouts, Layers, Header, Footer.

Views can be grouped together into reports to in order keep views organized. See Section 6.5 for further reading.
NOTE: **Click ‘Save View’ after modifying any view settings. This will ensure that any changes are saved into view file. It is recommended that each view be given a meaningful name, so they can easily be retrieved. Closing unused views will keep graph area tidy and speed up the software refresh time.**

### 7.2 Plot Header/Title

The graph title block reflects the information contained in the file that was chosen for the Main Header under the **Add Files** dialog box (refer to Section 6.1). This information can be edited or changed at any time by choosing **Header** located under the **Edit** menu. Alternatively, this dialog can also be accessed by right-clicking the title block of any plot.

**Figure 7-3 Edit – Main Header dialog box**

The header is broken down into four main sections:

1. **Title** – Gives the option of making the title visible or not and changing its colour (left click on the colour box). The header font can be manipulated by pressing the **Font** button.

2. **Information Block** – This can be made visible or hidden. The font can be manipulated by pressing the **Font** button. Header information can also be edited here.
• The **Insert Icon** button launches a dialog which allow the user to insert an icon, logo or other graphic into the header. This icon can be placed to the left right, or middle of the information block. The icon will be visible if the information block is also visible.

• **Location, Northing, Easting** and **Collar** are text information fields, editable by the user.

• **Applied Azimuth** allows rotating of the plot axis if azimuth correction is desired. This value is used by the Inclinalysis™ software to recalculate data; it represents displacements in the desired direction only. Enter the azimuth of the new A+ axis in the counter-clockwise direction from the grooves marked as A+. Alternatively, the negative azimuth value would represent the azimuth of the new A+ axis in the clockwise direction.

• The default **Collar Elevation** is 0, unless edited by the user. Enter the desired collar elevation into the **Edit** box. The depth values on all graphs will be altered to reflect collar elevation. The data files are not changed when collar elevation is edited.

**NOTE:** **PROJECT NAME, DEPTH AND BASE READING CANNOT BE CHANGED, AS THESE ARE READ FROM THE SURVEY DATA FILE ITSELF.**

3 Custom Title – custom text can be placed in the plot’s header. Text can be typed into the blank dialog box.

4 Margins – header margins are in inches and can be adjusted by changing the values in the corresponding dialog boxes.

### 7.3 TEXT VIEW

A text view opens a window in which the user is able to view both the raw and calculated data in table format. To open a new text view, choose **New View → Text View** under the **View** menu. A screen similar to Figure 7-4 will appear.
The left-hand column displays the current datasets loaded and active in the report (if certain datasets have been disabled in the Add/Remove Borehole Menu, they will not be displayed here). By expanding the branch next to each file in the left-hand column, details on that particular dataset are revealed. These include: reading units, reading date/time, hole depth, depth interval, and file location. Bullets along the top of the screen allow the user to view each data manipulation type (raw data, mean deviation, incremental displacement, absolute position, cumulative displacement and checksum).

The raw or calculated data displayed in the Text View can be exported by selecting Export TextView Data... under the Borehole menu. The exported data file will be automatically named (using the nomenclature described below) and saved in CSV format in the same folder as the original data file. For example, if the data file is “BH2_3.csv” and the Incremental Displacement data type is selected, the exported and automatically saved file will be called “BH2_3.csv.Incremental.TextView.csv” and will be located in the same folder as the original file. Here are a few more nomenclature examples:

- BH2_5.csv (Mean Deviation) → BH2_5.csv.Mean.TextView.csv
- FraserBorehole3.bch (Absolute Position) → FraserBorehole3.bch.Absolute.TextView.csv
- dh93cc6s1.csv (Cumulative Displacement) → dh93cc6s1.csv.Cumulative.TextView.csv
- P3-4(1).rpp (Checksum) → P3-4(1).rpp.Checksum.TextView.csv
- North_10453.csv (Raw Data) → North_10453.csv.RawData.TextView.csv
NOTE: CALCULATED DATA INCLUDES ANY APPLIED SPIRAL AND AXIS AZIMUTH CORRECTIONS.

8 MANIPULATING PLOTS

Once a plot is created, it can be manipulated to better facilitate data analysis.

8.1 PLOT OPTIONS

At any time, right-clicking the mouse on the plot area will bring up a list of options (Figure 8-1). These options are described in detail in the following sections.

![Figure 8-1 Plot Options](image)

8.1.1 The Cursor

The cursor can be used to identify specific data points on the graph, and to take direct measurements off the graph. This can be a powerful tool if you wish to know the difference between two points on a plot.

The cursor fly-out has the following options:
FIGURE 8-2 CURSOR OPTIONS

- Setting the cursor to **Free** allows it to be placed anywhere within the plot area.

- **Snap To Point** will snap the cursor on any specific data point within the plot.

- **Lock To Point** locks the cursor on a particular point in a specific data set.

- If the **Link Cursors** option is selected, the cursors on both the A and B axis plots are tied together. Placing the cursor on a point on the A-axis also moves the cursor to the complimentary point on the B-axis (please note that cursors are only linked if the snap to point and lock to point options are selected).

- Selecting **Set Measure Point** places a measurement point in the current cursor position. This allows the user to make a quick measurement between the set point and the subsequent cursor position. In order to view the resultant measurement, the cursor text must be set to **Measurement** and the measurement point must be set to visible.

- Selecting **Properties** brings up the following screen:
Various options are available to change the cursor properties:

- The top portion of the dialog box allows the user to show or hide the cursor, change its colour and show or hide the static measurement point.

- Using the drop-down box for Location positions the reported text around the cross-hairs of the cursor.

- The Text drop-down box gives the user the options of none, reading, depth, depth/reading, measurement or file name.

- Cursor geometry is adjusted by the drop-down menus in the centre of this window. These options include style and horizontal and vertical length.

- The data point style and size can be adjusted by the drop-down menus at the bottom the window.

Cursor properties can also be accessed by left-clicking the + icon in the bottom left hand corner of the plot screen (Section 8.1.7). The status of the cursor is revealed by the letter in subscript beside the icon:

- +F = Free
- +L = Lock to Plot
• +S = Snap to Point

8.1.2 Panning

Selecting the Pan option allows the user to choose between panning in the x only, y only, or both the x and y directions simultaneously.

![Pan Options](image)

**FIGURE 8-4 PAN OPTIONS**

Panning can also be selected by clicking on the hand icon in the bottom left corner of the screen. Clicking with the left mouse button reveals the same options as the pan menu (Section 8.1.7).

8.1.3 Zoom Functions

The Zoom option allows the user to zoom a single axis or both axes.
Zoom options can also be accessed by left-clicking the magnifying glass icon at the bottom left hand corner of the screen (Section 8.1.7).

### 8.1.4 Axis Properties

Options that are available under the axis fly outs are **Properties**, **Auto Scale**, and **Link Axis**. The following dialog box will appear:
**FIGURE 8-6 AXIS OPTIONS**

X-axis and Y-axis properties can be adjusted by selecting them from this list, or by right-clicking directly the axis of interest. Axis properties appear as follows:

**FIGURE 8-7 AXIS SCALE**
Various features are presented which can be used to manipulate the X-axis (Figure 8-7). A similar dialog box opens when changing the properties of the Y-axis. Options include **Scale**, **Units**, **Label**, **Ticks** and **Gridlines**:

- **Scale** – This option adjusts the scale of each axis. A minimum and maximum range can be specified. If the user desires, enabling **Centre Graph** gives the option of specifying a centre point and a range for the data instead of a minimum and maximum (Figure 8-8). Graph major and minor units can either be set manually, by typing the values in the appropriate boxes, or automatically by placing a checkmark beside the **Auto** option. **Base Units** centres the plot scale around that unit (default is zero).

![Figure 8-8 CENTRAL GRAPH OPTION](image)

- **Units** – The particular unit of measurement is automatically set by the properties of the inclinometer survey data (i.e. if the survey is taken in mm, the program will plot the data in mm). This dialog gives the user the option to set the notation (general or scientific) of the axis labels and the number of significant figures displayed. The font properties (size, colour etc.) can also be edited. See Figure 8-9.
- **Label** – Selecting the label tab (Figure 8-10), the user has the ability to reveal/hide the units label and specify a custom label. The font colour can be manipulated by clicking on the colour box and the font properties by clicking on the **Font…** button.

- **Ticks** – Major and minor ticks for each axis can be adjusted by selecting the **Ticks** tab (Figure 8-11). Options available allow the editing of both size and placement of the major and minor ticks.
• **Grid Lines** – The colour, size and shape of the gridlines can be adjusted under the **Gridlines** tab (Figure 8-12).

![Figure 8-11 Axis Ticks](image)

**Figure 8-12 Axis Gridlines**
8.1.5 Graph Properties

Various graph properties can be manipulated through the Graph Properties fly out, as illustrated in Figure 8-13.

![Graph Options](image)

**Figure 8-13 Graph Options**

- **Add Files to View…** – This option invokes a screen showing the inclinometer survey files which have been assigned to the particular plot or view (Figure 8-14). The same function is located under the View menu (**Add Files to View…**). For information on adding and removing files for the complete borehole/report please refer to Figure 6-9 and associated discussion.
This function is particularly useful if there are large numbers of datasets and the user only wishes to plot a few of those datasets. In this case, the user would select **Include All**, and then would remove the check mark for those files that are to be included. Next, press the **Invert Included** button and those files that were just un-checked would now be included and the others excluded. The window also has the ability to auto-select the most recent files and hide certain files temporarily.

**NOTE:** **INDIVIDUAL SURVEY FILES CAN ALSO BE HIDDEN BY LEFT-CLICKING DIRECTLY ON THE FILE OF INTEREST ON THE GRAPH LEGEND. CLICKING AGAIN REVEALS THE FILE.**

- **Header** – points the user to the same dialog as shown in Figure 7-3. For more information, please refer to Section 7.2.
- **Title** – Clicking the title option brings up the following screen:
This option allows the user to specify a custom title for the graph, change the position of that title and choose a specific font, size and style.

- The **Footer** tab invokes the following screen:

  ![Graph Footer Screen](image)

  **Figure 8-16 Graph Footer**

  Any text required in the footer can be typed into the dialog box. Footer alignment, position, specific font, style and size can also be adjusted.
The **General** options tab allows the user to change appearance of the graphs:

- **Graph Area Settings**: the user can change background colours of the plot and graph areas (simply click on the colour box for a list of colours). The annotation textbox drop shadow effect can be disabled by placing check mark in the checkbox. In order to change graph display order (draw plots in time descending order newest first) place checkmark into **Draw Plots Descending**.

- **Custom View Settings**: all user customizable settings are saved after pressing **Save Current Settings** button. For the instructions on how to selectively activate custom settings, refer to Section 8.1.4.

- **Plot Custom Properties**: click on **Edit Custom Properties** to modify settings saved in previous step. See Figure 8-18 for the sample dialog.

- **Display**: The user can choose between plotting both A and B axes at the same time or plotting a single axis.
• **Plot Properties** – opens a new window displaying the current files loaded in the borehole. Left clicking directly on one of these files will bring up the following dialog:

![Custom Plot Properties dialog](image)

**Figure 8-18 Custom plot properties**

The plot properties settings allow the user to change the way how each data set is displayed on the graph. If any settings were modified using the **General** options tab, this step overrides those settings allowing further customization of the graph display. Settings include the colour (click on the

![Graph and plot properties](image)

**Figure 8-19 Graph and plot properties**
colour box for a list of options), line width, line style, point size, and point style. The plot name can be changed by pressing the Plot Name... button. This permits a custom name for a particular dataset. When finished, press OK, or else press Cancel. To exit the full plot properties window, simply close it, minimize it, or use the windows menu to arrange the currently active windows.

NOTE: THE PLOT PROPERTIES FUNCTION IS A GLOBAL COMMAND IN INCLINALYSIS™. THEREFORE, ALL DATASETS WHICH HAVE BEEN ADDED TO A REPORT WILL BE SHOWN IN THE PLOT PROPERTIES WINDOW. THIS INCLUDES DATASETS WHICH HAVE BEEN DISABLED IN THE ADD/REMOVE BOREHOLE FILES MENU. ANY CHANGES TO THE PLOT PROPERTIES WILL AFFECT ALL PLOTS CREATED IN THE REPORT.

8.1.6 Legend

The legend can be revealed or hidden by choosing Show Legend. The physical positioning of the legend on the graph can be changed by selecting the desired option in the list. When Properties is chosen, the same window is opened as shown in Figure 8-19.
The user also has the option of hiding/revealing particular datasets on the graph. Simply left-click the particular dataset in the legend and it will hide the data on the plot. Left-click the dataset once again to reveal it.

8.1.7 Shortcut Keys

Graph manipulation shortcut keys are located in the bottom left hand corner of all plots. These functions are the same as those found under the plot options menu (right-clicking the plot area). The keys appear as follows:

![Figure 8-21 Graph shortcut keys](image)

The keys represent the cursor, pan, zoom, draw and annotation functions, respectively. To use a key, simply left click on one to select the desired option.

8.2 Graph Coordinates

At all times, the true coordinates of the cursor are reported in the bottom right-hand corner of the graphing window.

![NOTE: The graph coordinates reported in the bottom right-hand corner of the screen represent the true position of the cursor within the data file. In order to take a measurement on the graph, the user must enable the text on the cursor itself and set the text options to Measurement, which is found in the cursor properties dialog box (Section 8.1.1).]

8.3 Top and Bottom Reference

In general, most inclinometer installations are designed to be completed in stable ground. Cumulative Displacement plots are thus created assuming the base of the borehole is at “zero” displacement. Data is summed from the base of the borehole to the top of the borehole (in the same manner as the inclinometer survey is performed).

However, in certain situations the base of the inclinometer case may not be in stable ground and the user may instead wish to be referenced from the top of the borehole. Inclinalysis™ provides the option of changing this reference as outlined below.

![NOTE: Inclinalysis™ defaults to a bottom reference for cumulative displacement plots, as this is the most common setting for most applications.]

To change the reference setting:
1 Under the **Edit** menu, select **Reference**... and the following dialog will appear:

![Reference dialog](image)

**Figure 8-22** Borehole reference

2 Select the desired reference type and press **OK**.

Inclinalysis™ will automatically correct the reference point for the data.

**NOTE:** Since it is not measured, there is no data for the tilt at depth 0. It is assumed that at depth 0, the tilt will be 0.

Graph can be artificially extended to depth 0 by checking *Affix collar at (0,0)*. Similar option is given to draw cumulative graphs with common origin.

### 8.4 Depth Drop-Down Box

The depth drop-down box is located in the main toolbar of the program (illustrated in Figure 8-23).
Selecting a depth from this box will highlight that data point on every data display window currently open in the program. In this manner, you can directly compare a point on the graph (with the cursor visible) to the corresponding data point in a text view. The following steps outline an example of how this can be achieved:

1. Create a plot of the cumulative displacement.
2. Make the cursor visible and select the **Lock to Plot Option** (Section 8.1.1).
3. Lock the cursor to the dataset of interest.
4. Create a new text view.
5. Under the **Window Menu** choose **Tile Vertically** to display both these graphs side-by-side on the screen.
6. Click on the Depth drop-down box and choose a depth either with the mouse or by using the arrow keys. The depths can be scrolled through by using the arrow keys provided the cursor focus in placed with the drop-down box.
7. The corresponding data points will be highlighted on both the graphs. Similar actions can be used with the time and vector plots.
8.5 Reading Units

The user has the option of specifying what types of units are displayed in the x-axis of each plot. Available units include: millimetres, metre, inches and feet. To change the units, go to the Edit menu and select Reading Units. Choose the desired unit from the window fly-out list (Figure 8-24):

**Figure 8-24 Reading Units**

**NOTE:** Reading units cannot be changed while a text view is active. Please make an axis, time or vector plot active before changing the reading units. Once adjusted, you can return to the text view and the change will have taken effect.

8.6 Depth Units

The y-axis units are automatically set to meters or feet depending on whether the data files were recorded using a metric or imperial inclinometer probe. Inclinalysis™ software gives users the option to recalculate the y-axis scale and force it to display either meters or feet depth units. To activate custom depth units display, uncheck the Data Based option under the Edit menu and select desired units. The choice of depth units will be reflected on all graphs and dialogs for all boreholes.
NOTE: CUSTOM DEPTH UNIT OPTION IS PROVIDED MAINLY FOR GRAPH DISPLAY. DATA INTERVAL CONVERSIONS MAY RESULT IN FRACTIONAL NUMBERS AND CERTAIN FEATURES WILL USE ROUNDED VALUES. IT IS RECOMMENDED TO SWITCH TO NATIVE DATA FILE DEPTH UNITS WHEN CHANGING DATA DISPLAY PROPERTIES.

8.7 MOVEMENT ZONE

Depth movement over specific zone can be shown using a custom depth range in Inclinalysis™. This is called the Movement Zone. Please note that the Movement Zone function only applies to the time and vector plots.

The Time Plot function displays the cumulative value of displacement at one selected depth over time. This depth can be selected in the main menu of Inclinalysis. It is not possible to display a time plot for a range of depths on one graph.

CAUTION: THE TIME PLOT FUNCTION DISPLAYS DISPLACEMENT AT ONLY ONE DEPTH OVER TIME. IT IS NOT POSSIBLE TO DISPLAY A TIME PLOT FOR A RANGE OF DEPTHS ON A SINGLE GRAPH.

The Movement Zone function is disabled by default. When this is the case, the bottom reference is the bottom of the borehole. When the Movement Zone is enabled, the bottom reference is set to the depth defined in the Movement Zone dialog box.
Similarly, when the Movement Zone function is disabled, the data is referenced to the top of the borehole. When enabled, the top reference is set to the depth defined in the Movement Zone dialog box.

The following steps outline how to define and display a movement zone:

1. Click on a time or vector plot to make it active.
2. Under the Edit menu, select Movement Zone…. The following screen will appear:

![Movement Zone Dialog](image)

**Figure 8-26 Movement Zone Dialog**

3. To enable the movement zone, place a check in the upper box. The range of the zone can be specified by typing the desired values into the appropriate boxes. **Top of Zone** applies to top referenced plots, and **Bottom of Zone** applies to bottom referenced plots. Refer to Section 8.3 for reference point selection.

Once enabled, the user-defined movement zone will appear in the title of both the Time and Vector plots. The depth drop-down box can be used to scroll through the zone if desired (Section 8.3). It is useful to turn the cursor on and set the cursor text to display Reading. The date of each survey file will be displayed when points are chosen on the Time Plot. Using this method, the history of movement for a particular zone is easy to trace.

**NOTE:** **Movement Zone settings are part of Graph View. Each individual Graph View can have separate Movement Zone settings.**

### 8.8 Bias-Shift Correction

If the inclinometer probe is suspended in an absolutely vertical position, it will typically read a non-zero value. This is the probe’s bias, or zero, offset. From the factory this value is exceedingly small, however over the life of the probe this value will tend to shift. This is the result of the normal bumps and shocks that occur during shipping and normal use. Mishandling of the probe can lead to its bias increasing at a greater rate and magnitude. RST recommends that the Digital Inclinometer probe
be returned to the factory for calibration annually, or more frequently if the probe is mishandled and the data reflects this.

In general, bias shifts are not of tremendous concern as the bias is virtually eliminated by passing the inclinometer twice through the casing (once in the A+ direction and once in the A- direction).

Bias-shift errors occur when the data processing is unable to completely eliminate the bias. This occurs when the bias changes between surveys. The bias-shift can be systemic, therefore propagating itself as a linear error on cumulative displacement plots. Data will appear to have a horizontal translation in relation to other datasets.

The most common factors leading to bias-shift are:

1. **Mishandling of the probe**: This can range from bumping the probe on the side of the inclinometer casing to accidentally dropping the probe.

   **CAUTION: ALWAYS STORE THE PROBE IN ITS CASE WHEN TRANSPORTING IT AND WHEN IT IS NOT IN USE.**

2. **Inadequate warm-up time**: As indicated in the Digital Inclinometer System Manual, warm-up time is crucial when performing an inclinometer survey. After the probe is lowered to the bottom of the hole, the user must wait at least 10 minutes to allow the probe to adjust to the temperature in the bottom of the borehole. Failure to do so will result in a bias-shift error for the first 10 minutes of readings as the probe is pulled upwards. Because the probe is adjusting to the temperature, the bias-shift will drift and will show apparent movement in the bottom of the borehole.

   Inclinalysis™ provides an easy way to correct data for systematic bias-shift errors. It allows a separate correction for both the A and B axes. This is due to the fact that each sensor will generate its own bias shift. The correction is only applied to an individual dataset according to the amount of bias that has occurred during the time of the survey.

The following steps outline how to correct for bias-shift:

1. **Launch Inclinalysis™ and open a Cumulative or Incremental Displacement plot. Bias-shift errors will tend to show up most prominently on a Cumulative plot as it is a systemic error.**

2. **Under the Edit menu, choose Bias-Shift Correction…. A dialog box similar to the Add/Remove Borehole Files… option will appear (Figure 8-27).**
Select the desired survey file and press the Bias-Shift Correction button. In Figure 8-27, the file BH2_2.csv was chosen. The following dialog box will appear:

![Bias-Shift Correction Dialog Box](image)

**FIGURE 8-27 BIAS-SHIFT CORRECTION DIALOG BOX**

3 Select the desired survey file and press the Bias-Shift Correction button. In Figure 8-27, the file BH2_2.csv was chosen. The following dialog box will appear:

![Bias Shift Properties](image)

**FIGURE 8-28 BIAS SHIFT PROPERTIES**

4 Be sure to place a checkmark in the box labelled Enable Correction.

5 Enter the Depth and the Reference Point for the bias-shift correction (Figure 8-28). The Reference Point is the location on the graph that you would like that data to pass through. Inclinalysis™ will automatically adjust the rest of the data points in order to correspond with the plot passing through this reference point. This example makes the A-axis plot for the file BH2_2.csv pass through 10 mm at a depth of 10 metres. Press OK when complete.
With the bias-shift correction enabled, **bias** will appear next to the specified dataset on the plot and the data will be shifted according to the factors inputted above.

**Figure 8-29 Bias correction example**

The bias-shift correction will occur globally on all plots (including time and vector plots) with the exception of the checksum plot.

**NOTE:** If desired, the cursor can be used to determine the reference point for the bias-shift correction. This can be accomplished by enabling the snap-to-plot function and displaying the graph coordinates. It is possible to place the cursor on an existing point of a dataset and correct another dataset to pass through the same point. For more information on the various functions of the cursor, please refer to Section 8.1.1.

### 8.9 Spiral Correction

The RST Digital Spiral Probe is used to determine the true azimuth of inclinometer casing after installation. Spiral is typically of concern in deep installations, however, should poor installation be suspected, or an installed spiral be of interest, a spiral survey can be conducted using this tool. Inclinalysis™ has the ability to read the spiral data file and perform a spiral correction automatically. Inclinalysis™ currently supports Spiral Survey Files from the RST Digital Spiral Probe. Spiral data files
produced by the SINCO Spiral Probe can be converted to RST Spiral format using the Spiral file Format Converter utility included on Inclinalysis™ installation CD.

For the RST System, the spiral data will be stored in a ".csv" file format on the Pocket PC. Using the SINCO Spiral Tool, the data must be downloaded with the DMM for Windows software and then exported. Please refer to section 10.2 for further information.

For additional information on performing a spiral survey please refer both the RST Digital Inclinometer System Manual and the RST Digital Spiral Probe Manual (both of which are included with the system and are available on our website).

The following procedure outlines how to apply the spiral correction to a set of inclinometer survey data:

1. Once a spiral survey has been completed, copy the spiral survey file (*.twi or *.txt) to the appropriate site and borehole file on your desktop computer in the same manner you would copy a new inclinometer survey file.

2. Under the Edit Menu, select Spiral Correction…

3. A dialog box should appear that shows the current inclinometer survey files which are loaded into the report (Figure 8-29). Press Add and navigate to the location in which you placed your spiral survey file in *.csv format (RST). If you copied the file to the borehole directory, it will appear on the list with the rest of the survey files.

4. Press Open and the file will be added to the current list of files.

5. Press Apply and the spiral correction will be automatically performed on the current data sets. Confirmation of the spiral correction will be shown in the top right of the title bar, which should read “Spiral Correction: Enabled”, as shown in Figure 8-31:

![Spiral Correction Dialog](image)

**Figure 8-30 Spiral correction dialog**
To disable the spiral correction, under the Borehole Menu choose Add/Remove Borehole Files… (Figure 8-30). Place a check mark in the box to the left of the spiral file (*.twi or *.txt) to disable it.

8.10 Indicating Layers on a Graph

In order to indicate layers of settlement underground, the area between layer borders can be filled with pattern or solid color.

To add a layer fill, click on Layers button on main toolbar. The Layers Edit dialog box will appear, as shown in Figure 8-32.
Click on **Insert** button to add new layer to the list. In the **Edit Layer** dialog, enter the “from” and “to” depths, layer color and select pattern or solid color option. The layer name is an optional label. Refer to Figure 8-33 for sample data entry.

**Figure 8-33 Edit Layer**

Figure 8-34 shows **Layers Edit** dialog box with several entries.
To edit existing layers, double-click on the desired entry or select it from the list and click **Edit Selected**. To remove unwanted entries, use **Delete Selected** or **Delete All**.

When using patterns to fill layer regions, the **Borders** check box can be selected to draw bounding lines to clearly indicate layers.

Layers can be individually hidden by checking boxes in first column. Alternatively, all layers can be hidden by checking **Hide All Layers** checkbox.

If required, label font, location and background color are adjustable using appropriate buttons.

**8.11 ANNOTATING PLOT POINTS WITH CALLOUTS**

Users can create descriptive callouts for each point on the plot by right clicking in the graph area and selecting the **Annotation** option. Notes and comments can be added to the graph.

Annotation can also be selected by clicking on the **text icon** in the bottom left corner of the screen (red circle, Figure 8-35). Clicking with the left mouse button reveals the same options as the annotation menu (green square, Figure 8-35; see Section 8.1.7 for more details).
Select **Point** from menu and then click on the desired plot point to choose the callout anchor. The red dot snaps to the nearest plot point indicating the choice. Click on **Callout** to begin creating text box (Figure 8-36) or choose **Paste** to insert previously copied callout.

Choose **Properties** from right-click menu or double-click text box to edit text or appearance of the callout box.
In the **Callout Properties** dialog box (Figure 8-37), various aspects of the callout’s appearance can be changed:

- **Line Properties**: modify style, width and color of the line. Turn on or off callout box border and arrowhead.

- **Line Attachment**: Change the line and box joining point.

- **Text Box Properties**: Specify fill color; turn on or off callout box border. Check **Transparent** check box to make a transparent callout box. Box corners can be rounded by selecting **Round Border Corners** checkbox.

- **Global Properties**: change text box shadow and text margins for all callouts on the graph sheet.

The location of each callout box can be changed by right clicking on the graph area and selecting **Move** or by clicking on the **text icon** in the lower left corner of the screen. The selected callout box can be dragged into the desired location, duplicated, copied into clipboard or deleted. The anchor point can be dragged to any point on displayed plots. All edits can be undone by using **Undo** command.

In the case of overlapping callout boxes, use **To front** or **To back** commands to change the order.
8.12 ANNOTATING GRAPHS WITH TEXT BOXES AND LINES

Text boxes similar to callouts can be inserted anywhere on graph area. Right click on the graph area and select the **Draw** option from right-click graph menu and then choose textbox or line element. Alternatively, the **Draw** option can also be selected by clicking on the line and textbox icon in the bottom left corner of the screen. Clicking with the left mouse button reveals the same options as the **Draw** menu (Section 8.1.7).

Choose **Properties** from right-click menu or double-click on the drawing element to edit the text or the appearance.

The selected drawing element can be dragged into the desired location, duplicated, copied into clipboard or deleted.

**FIGURE 8-38 DRAWING TEXT BOXES AND LINES**

All drawing elements feature anchoring properties. The following modes can be chosen for every individual drawing element:

- **Scalable mode** is enabled when the **Scalable** checkbox is selected. The size and location of drawing element are tied to the axis coordinates. Scale and unit changes will be reflected in changes to the location and size of drawing elements.
• Anchored point mode is enabled when the **Scalable** checkbox is cleared. Only one point of the drawing element will be adjusted when the coordinate system changes. Other element dimensions are fixed. The anchor point can be chosen individually for each element. In case of textbox, top-left or bottom-right corners can be selected as an anchor. For the line element, one of the line ends is designated as the anchoring point.

![Figure 8-39 Line Properties](image)

**Figure 8-39 Line Properties**

### 8.13 Software Options

The global software options (Figure 8-40) are included in the following dialog box. To selectively activate custom view settings, click on **Settings** button. Refer to the Section 8.14 for detailed instructions on selecting and saving custom view settings. The **Advanced** button opens the **Advanced Settings** dialog box. These settings are for diagnostic use only. They should not be enabled for normal program use; if diagnostic features are used incorrectly, an incorrect graph may be displayed.

![Figure 8-40 Software options](image)

**Figure 8-40 Software options**
8.14 **DATA INTERPOLATION**

In certain cases, survey data is collected at intervals greater than the probe length. Data is automatically interpolated by averaging adjacent points readings. Data interpolation is turned on by default in the **Advanced** settings dialog (see Section 8.13).

**WARNING:** **INTERPOLATING DATA SHOULD BE USED WITH CAUTION. USING MEASUREMENT INTERVAL GREATER THAN THE PROBE LENGTH WILL RESULT IN APPROXIMATE GRAPHS WHICH MAY BE INACCURATE.**

8.15 **CUSTOM VIEW SETTINGS**

At any time, the current view settings can be saved as custom view settings (Figure 8-41). Click on **Save Current Settings** in the **General** options tab to save the current settings into the Inclinalysis™ configuration file. Refer to Section 8.1.5 for description of General Options dialog box. When the first new view of the graph is created, the program will use custom settings if they are activated in Custom View Settings Selection dialog box, shown in Figure 8-41. By default, all settings are enabled. This dialog is accessible from Software Options dialog after pressing on **Settings** button.

![Custom View Settings Selection](image)

**FIGURE 8-41 CUSTOM VIEW SETTING SELECTION**

8.16 **FILLING OR EXCAVATING AT THE BOREHOLE LOCATION, CUTOFF DEPTH**

In the case where the borehole collar level changes, the Inclinalysis™ software provides the means to adjust ground level accordingly for proper data display. Enter the ground level adjustments in **Ground Level** dialog box, which is accessible from **Edit** menu. Enter negative value for excavations. Figure 8-42 shows a sample entry.
WARNING: THE BOREHOLE COLLAR LEVEL AND BE ADJUSTED IN INCREMENTS EQUAL TO THE PROBE LENGTH ONLY, WHICH IS 0.5M OR 2FT, DEPENDING ON DEPTH UNITS. IT IS ALSO VERY IMPORTANT TO ENTER THE CORRECT DATA. THE INCLINALYSIS™ PROGRAM WILL DETERMINE IF PLOTS NEED ADJUSTMENT BASED ON PROVIDED DATA.

### Figure 8-42 Ground Level Adjustments

Each ground level change will be marked on the graph with line and calendar date. To disable ground level markings, clear the Show Mark Line checkbox.

The Add/Remove Borehole Files table (Figure 6-9) will show which files are affected by ground level adjustment.

The graphs can be plotted representing borehole data for a specified depth. By specifying the cutoff depth, Inclinalysis™ will ignore borehole data below the cut off depth value.

WARNING: THE CUTOFF DEPTH IS MEASURE FROM THE CURRENT COLLAR LEVEL. CHANGES TO THE COLLAR LEVEL WILL AFFECT THE CUTOFF DEPTH.

### 9 Compatible File Types

The program is compatible with the following file types:

1. RST Digital Inclinometer Files (*.csv).
2 RST Analog Inclinometer (*.csv).

3 RST Analog Inclinometer (GI Format, refer to Section 10.1).

4 SINCO (*.rpp).

5 SINCO Spiral Survey (*.rpp, *.txt, *.prn).

6 BC Hydro (*.bch).

These file types are automatically recognized by the program in the **Add/Remove Borehole/Files...** screen (Section 6.1).

**WARNING: Inclinalysis™ will not open different files types in the same borehole view.**

## 10 IMPORTING RST INS 5.2 ANALOG INCLINOMETER DATA

### 10.1 CONVERTING FILES

Inclinalysis™ has the ability to automatically convert RST Analog Inclinometer files into the *.csv format which is used for plotting graphs in the program. This is an extremely useful function if you have existing analog inclinometer data that you wish to plot with Inclinalysis™. The following procedure outlines how to convert the analog data.

1. Under the Borehole menu, select **Open Borehole Site**. Either open an existing borehole or create a new borehole. If a new borehole is created, the data must be copied to the appropriate directory as outlined in the next step.

2. Using **Windows Explorer**, copy your analog inclinometer data to the appropriate directory. For example: If you created a new borehole called “Test Data” under a site name “RST” then your files should be placed in the folder: *DigitalInclinometer\RST\Test Data*.

3. In Inclinalysis™, open an existing borehole or the one just created.

4. Under the Borehole menu, select **Add/Remove Borehole Files...** and the following screen will appear:
5 Press the Convert Analog Files button. A dialog box will appear showing the following:

![Figure 10-1 Converting Analog Files]

6 Select whether the analog data has been taken in **meters** or **feet**. Place a bullet next to the appropriate choice.

![Figure 10-2 Adding Analog Files]
WARNING: IT IS IMPERATIVE THAT THE CORRECT DEPTH UNITS ARE CHOSEN FOR THE SURVEY. IF A SURVEY IS PERFORMED IN FEET AND METERS IS SELECTED, THE DATA WILL BE PLOTTED INCORRECTLY. YOU MUST CHOOSE THE CORRECT UNITS.

7 Press the **Add** button to select the analog files. Navigate to the appropriate directory where the analog files are placed (most likely in the borehole directory you just created). Select a single file or multiple files by using the Ctrl or Shift buttons. Press **Open** when complete. You will be returned to the screen as shown in Figure 10-2.

8 The analog files you chose will now be listed in the window. Highlight the desired file and press Convert File or press Convert All to convert all the files in the list. A dialog box will appear Analog File Conversion Successful or Batch Analog File Conversion Successful will appear if the conversion was completed successfully.

9 Press the **Close** button. You will be returned to the **Add/Remove Borehole Files** window.

10 Press **Add** to add the newly converted files converted.


10.2 **USING UNIDOWN SOFTWARE**

Inclinalysis™ can only interpret analog inclinometer data (INS 5.2) if it is in *.csv file format. Data can be uploaded using UNIDOWN and saved directly as a *.csv file. The procedure is as follows:

1 Launch **Inclinalysis™** software.

2 Under the **Borehole Menu**, select **Open**.

3 Press the **Create Borehole** button and create a new site and borehole corresponding to the data you are about to import.

4 In order to view the INS 5.2 data in Inclinalysis™, the files must be first downloaded from the logger as *.csv format.
5 Launch UNIDOWN.exe (free software supplied by RST Instruments Ltd.).

6 Select option C, Configure

7 Set the default path to a location where you would like to place the data. It is easiest to simply create a temporary directory on your hard drive to place the files and then move them later. For example, set the default directory to C:\INCLO or C:\TEMP. Please note that the directory must already exist, UNIDOWN will not create a new directory. You can use Windows Explorer to create a new directory.

8 Select option 3, Inclinometer.

9 Follow the on-screen instructions to connect to the INS 5.2 logger.

10 When the desired file is found, select it by using the arrow keys.

11 Type in an appropriate file name using the 8-character format followed by the .csv extension.

12 Using Windows Explorer, copy the data files from the temporary directory into the borehole folder that you created with Inclinalysis™ in steps 1-3 (above).

13 Go to Inclinalysis™ and add the data files to your new borehole using the Add/Remove Borehole Files function.

NOTE: IT IS IMPERATIVE THAT THE BOREHOLE FILES WHICH ARE DOWNLOADED IN *.CSV FORMAT WITH UNIDOWN ARE COMPLETE FILES. THIS MEANS THAT THERE IS DATA FOR EVERY INTERVAL AND THERE IS COMPLETE DATA FOR SURVEYS IN BOTH THE A+ AND A- DIRECTIONS. IF A BOREHOLE SURVEY WAS ONLY COMPLETED IN A SINGLE DIRECTION (I.E. THE PROBE WAS NOT TURNED 180 DEGREES AND THE SURVEY REPEATED) THE DATA FILE WILL NOT BE RECOGNIZED BY INCLINALYSIS™.

11 IMPORTING SINCO DATA

11.1 INCLINOMETER SURVEY FILES

Inclinalysis™ software has the ability to read Slope Indicator DigiTilt data. In order to accomplish this, the inclinometer survey files must be in the *.rpp file extension format. The following is a brief explanation of how to accomplish this using DMM for Windows software. For further information, please refer to the DMM users’ manual provided with your DigiTilt system. The manual can also be downloaded from Slope Indicator’s website: www.slopeindicator.com.

1 Launch Inclinalysis™ software.

2 Under the Borehole Menu, select Open.
3 Press the **Create Borehole** button and create a new site and borehole corresponding to the data you are about to import.

4 In order to view the DMM Project data in Inclinalysis™, the files must be first converted to *.rpp format.

5 Open your Project Database in DMM for Windows.

6 Select the dataset you wish to export to Inclinalysis™.

7 Right click that dataset and choose **Export To RPP** or under the **Survey Menu**, choose **Export to RPP**.

8 Navigate to the site and borehole you just created in steps 1-3. The directory structure follows the same format as explained in Section 5.

9 Go back to the Inclinalysis™ program.

10 Under the **Borehole** menu, select **Open Borehole Site** and choose the new borehole you created. Add the newly imported *.rpp files and select a base file.

11 Once imported with the program, the plot views can be saved as a **Report** (Section 6.5).

**NOTE:** **THE USER DOES NOT HAVE TO CREATE A NEW BOREHOLE IN WHICH TO PLACE THE *.RPP SURVEY FILES. IF REQUIRED, THE FILES CAN BE ADDED TO AN EXISTING BOREHOLE DIRECTORY. IN THIS MANNER DATA CAN BE COMPARED, PROVIDED THAT THE SAME MEASUREMENT UNITS WERE USED DURING THE SURVEY. IT IS ALSO EXTREMELY IMPORTANT THAT THE DEPTH REFERENCES BETWEEN TWO DIFFERENT SURVEY TYPES ARE THE SAME (I.E. PROBE IS POSITIONED IN THE SAME LOCATION IN THE BOREHOLE) OTHERWISE THE DATA CANNOT BE COMPARED WITHOUT SIGNIFICANT ERROR.**

### 11.2 SPIRAL SURVEY FILES

Inclinalysis™ has the ability to import Slope Indicator's spiral survey files and apply a spiral correction to either RST Digital Inclinometer files or other imported Slope Indicator files in *.rpp format (Section 11.1). The following instructions outline how to import the spiral data.

- Record a spiral survey as outlined in the SINCO Spiral Sensor Instruction Manual (50900199). Be sure to make a manual record of the probe’s zero offset.

- Download the data from the Datamate using DMM for Windows Software.

- Highlight the Spiral Survey file in DMM for Windows.
• Under the Survey menu, select the Export fly-out and choose any of the following options: To RPP (*.rpp), Tab Delimited ASCII (*.txt) or To PCSLIN (*.prn). Inclinalysis™ is compatible with all 3 file types.

• Navigate to the directory in which your inclinometer survey files are located. Type a name for the file and press Save.

• Follow the instructions outlined in Section 8.9 for applying the spiral correction.

12 USB SECURITY KEY DRIVER INSTALLATION

The following instructions describe typical driver installation on Microsoft™ Windows 7 and Microsoft™ Windows 10 platforms. The actual screenshots may differ, but the steps will be very similar.

12.1 MICROSOFT™ WINDOWS 7 AND WINDOWS 10 INSTALLATION PROCEDURE

1 After successful installation of USB Security Key device drivers, the following dialog box is displayed.

![KEYLOK Security Key Installer]

Figure 12-1 USB security key drivers installed notification

2 At this point, the USB key should be inserted into the USB port.

3 The MS Windows system should detect the new device and display KEYLOK Security Key Installer, as shown on Figure 12-2.
4 The Wizard will install device drivers and display the following screen. Click Finish to complete the device drivers installation.
After successful installation, the yellow message balloon (Figure 12-5) should be shown in the lower right-hand corner stating that all device drivers are installed and ready to use.

Alternatively, correct installation of the device drivers can be verified by navigating to the Windows Control Panel, choosing System and then selecting the Hardware tab. Clicking on Device Manager will bring up the following screen:
If the driver was installed correctly, the USB Dongle – Software Protection Device will appear as in Figure 12-6 above. If the driver has not been installed correctly, yellow exclamation mark will appear next to the device.

13 TROUBLESHOOTING

Problem: The program will not open or crashes continuously.

Solution: Delete the file Inclinalysis.ini and the folder named Default Site from the directory in which the program is installed. Also delete the Default Report directory and Graph.ini file from the borehole directory. Do not delete any *.dgi files from the borehole directory.

Reason: The *.ini files track all changes being made within the program (auto-save feature). This, in turn, keeps track of your most recent work allowing the program to bring up the last borehole you were working on. Sometimes these files can become corrupted.

Problem: The program fails to recognize USB Security Key
Solution: Windows 7, 8.1 or Windows 10 operating system.

1. Remove USB dongle from USB port. Exit Inclinalysis software if open.

2. Run Start → All Programs → RST Instruments → Inclinalysis → Tools → Install Dongle Drivers.

3. Put a checkmark into Uninstall. Don't change any other options.

4. Click Begin Uninstall. Make sure to check remove driver files if the message pops up.

5. The dialog with successful uninstallation message should pop up. Click Close.

6. Run Start → All Programs → RST Instruments → Inclinalysis → Tools → Install Dongle Drivers again.

7. Put a checkmark into KEYLOK 2 (USB w/Driver) option. Do not change any other options.

8. Click Begin Install. The dialog with successful installation message should pop up. Click Close.

9. Allow installation if any Windows security warnings show up.

10. Successful driver installation message dialog should pop up. Click Finish.

11. Plug in USB Dongle into USB port. A message balloon should pop up stating the successful installation of the device.

Reason: USB Security Key driver installation failed for some reason.

Problem: The Inclinalysis™ program opens a large number of views.

Solution: Manage open views using Select View dialog box that is accessible from View → Open View... menu option. In Select View dialog box, delete unwanted views as well as select which views are open. Inclinalysis™ software will open only those files that are flagged Open.

Sometimes the Inclinalysis™ software opens too many views when program is started by double-clicking *.dgi files. To avoid this situation, it is recommended to open boreholes using Borehole → Open menu selection and then selecting the desired borehole or browse for files.

Reason: The Inclinalysis™ software opens many configuration files, occasionally some files are not written on time by operating system.

For further troubleshooting advice, please contact RST Instruments (see Section 14 for contact information).
14 CONTACT US

Sales information: sales@rstinstruments.com
Technical support rst_support@rstinstruments.com

Head office: 11545 Kingston St.
Maple Ridge, BC
Canada, V2X 0Z5

Our office hours: 8:30am – 5:00pm
Monday – Friday (excluding holidays)

Telephone: 604-540-1100
Facsimile: 604-540-1005
Toll free: 1-800-665-5599
Website www.rstinstruments.com